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These release notes contain requirements, download, installation, and configuration instructions, new
and changed requirements and support, new and changed functionality, limitations and restrictions, and
caveat information for Cisco ViewMail for Microsoft Outlook Release 9.0(2).

ViewMail for Outlook 9.0(2) is available only from the Cisco Download Software website.

Note  For full access to the Download Software website, you must be signed in to Cisco.com as a registered
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W Introduction

Introduction

Cisco ViewMail for Microsoft Outlook provides a visual interface with which users can send, listen to,
and manage their Cisco Unity Connection voice messages from Outlook. ViewMail for Outlook also
allows Cisco Unity users to listen to their voice messages from Outlook.

Users can be set up with ViewMail to access Cisco Unity voice messages in Exchange, or to access
Connection voice messages by using IMAP or by using the single-inbox feature (synchronization of
Connection and Microsoft Exchange mailboxes). Note the following considerations with ViewMail for

Outlook:

Single inbox users

Users get voice messages in the same Inbox as their email.

With Cisco Unity Connection 9.1(1) and later, new voice messages get
identified by a separate voice message icon.

Voice messages sent from Outlook do not appear in the Sent Items folder.

ViewMail for Outlook is not required with the single inbox feature. Without
it, however, users can only play voice messages; they cannot compose, reply
to, or forward them.

ViewMail for Outlook is required for users to play secure messages in the
Exchange mailbox.

IMAP users

Users get voice messages in a separate mail folder in Outlook.
New voice messages get identified by a separate voice message icon.

ViewMail for Outlook is required for users to play secure messages in the
Connection mailbox.

Cisco Unity users

Users get voice messages in the same Inbox as their email.

Users can play unsecure voice messages by using audio devices on their
computers.

Users can play secure and unsecure voice messages by using their phones.

Users cannot compose, reply to, or forward voice messages.

~

Note ¢ On Windows operating system with ViewMail for Outlook, the text of the voice messages appears
in black color and the ViewMail category appears in blue color. However, on MAC operating system,
the text of the voice messages and the ViewMail category appears in the system default color.

e  When there is no default recording device available on the Windows machines and the user selects
the recording device from Phone to Computer Default option then ViewMail for Outlook will always
consider Phone as default recording device.

Requirements

Revised May 13, 2013

e The ViewMalil for Outlook version must be supported with the version of Outlook that is installed
and the operating system. See the applicable documentation:
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Requirements W

— The “ViewMail (With Connection 9.x and Connection in Cisco Unified CMBE 9.x)” section of
Compatibility Matrix: Cisco Unity Connection and the Software on User Workstations at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/compatibility/matrix/cucclient
mtx.html.

The following software installed on the user workstation:
— Microsoft DirectX
— Microsoft .NET Framework 3.5
— Microsoft Visual C++ 2008 Redistributable Package
(If the software is not already installed, ViewMail for Outlook Setup installs it.)

To install or upgrade ViewMail for Outlook, you must have local administrator rights on the user
workstation.

The user workstation must have at least 10 MB of hard-disk space available for ViewMail for
Outlook. (If other required software is being installed,100 MB or more may be required.)

Cisco Unity Connection versions 9.x and 8.x, and Cisco Unity versions 8.x and 7.x support
ViewMail for Outlook version 8.5(6) and later.

To use the telephone playback feature with Cisco Unity version 7.x, you must install Cisco Unity
Voicemail Web Service (VMWS) on the Cisco Unity server.

If the proxy is enabled on the user workstation, then it must be connected to port 443 (HTTPS) to
allow the communication between ViewMail for Outlook and Cisco Unity Connection.

See also the “Prerequisites” section on page 6 of these release notes.

Compatibility Information

For information on all qualified version combinations of ViewMail for Outlook, Cisco Unity
Connection, and the software on user workstations, see Compatibility Matrix: Cisco Unity
Connection and the Software on User Workstations at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/compatibility/matrix/cucclientmtx.
html. The document also contains the support policy for software on user workstations.

For a list of all languages available for ViewMail for Outlook, see the “Available Languages for
Cisco Unity Connection Components” section of System Requirements for Cisco Unity Connection
Release 9.x at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/9x/requirements/9xcucsysreqs.html

Determining the ViewMail for Outlook Version

Revised June 14, 2013
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Related Documentation

To Determine the ViewMail for Outlook Version in Use from Outlook

In Outlook on the user workstation:

Outlook 2010 and 2013  |On the ViewMail tab, select About Cisco ViewMail.

Outlook 2007 and 2003 | From the Help menu, select Cisco ViewMail for Outlook > About Cisco
ViewMail.

Related Documentation

Note

For descriptions and URLs of Cisco Unity Connection documentation on Cisco.com, see the
Documentation Guide for Cisco Unity Connection Release 9.x. The document is shipped with
Connection and is available at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/9x/roadmap/9xcucdg.html.

The Quick Start Guide for Cisco ViewMail for Microsoft Outlook (Release 8.5 and Later) is available at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/vmo/quick_start/guide/85xcucqsgvmo.
html.

New and Changed Requirements and Support—Release 9.0(2)

There are no new or changed requirements or support in this release.

Additional Languages for ViewMail for Outlook

Revised July 16, 2013
All locales are now released for ViewMail for Outlook 9.0(2) release.

For a list of all languages available for ViewMail for Outlook, see the “Available Languages for
Cisco Unity Connection Components” section of System Requirements for Cisco Unity Connection
Release 9.x at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/9x/requirements/9xcucsysreqs.html.

New and Changed Functionality—Release 9.0(2)

There are no new or changed functionality in this release.
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Installation and Upgrade Information

e Task List for Installing ViewMail for Outlook 9.0(2) for the First Time, page 5

e Task List for Upgrading to ViewMail for Outlook 9.0(2), page 5

e Prerequisites, page 6

¢ Downloading ViewMail for Outlook 9.0(2), page 9

e Customizing ViewMail for Outlook Setup, page 9

¢ Installing or Upgrading to ViewMail for Outlook 9.0(2), page 10

¢ Installing ViewMail for Outlook 9.0(2) Using Command Line Switches, page 10

e Associating the Applicable Email Account with the Voicemail Server, page 11

Task List for Installing ViewMail for Outlook 9.0(2) for the First Time

Do the following tasks in the order listed for a new ViewMail for Outlook installation.

1. Confirm that ViewMail requirements and prerequisites have been met. See the “Requirements”
section on page 2 and the “Prerequisites” section on page 6.

2. Download ViewMail for Outlook from the Cisco Download Software website. See the
“Downloading ViewMail for Outlook 9.0(2)” section on page 9.

3. Optional: Customize ViewMail for Outlook setup. See the “Customizing ViewMail for Outlook
Setup” section on page 9.

4. Optional: Provide users with ViewMail for Outlook files for installation.

5. Install ViewMail for Outlook. Provide users with instructions, if applicable. See the “Installing or
Upgrading to ViewMail for Outlook 9.0(2)” section on page 10.

6. Link users’ email accounts with the voicemail server:

a. Using the ViewMail for Outlook Initialization wizard: When they restart Outlook following
ViewMail installation, the Initialization wizard prompts users for any required information that
was not already prepopulated.

b. Using the ViewMail Options or Settings dialog: Enter the required information. Provide users
with instructions, if applicable. See the “Installing ViewMail for Outlook 9.0(2) Using
Command Line Switches” section on page 10.

Task List for Upgrading to ViewMail for Outlook 9.0(2)
~

Note  If you are upgrading from a ViewMail for Outlook version earlier than 9.0, see the “Task List for

Installing ViewMail for Outlook 9.0(2) for the First Time” section on page 5 instead. The older version
is uninstalled automatically, and installing 9.0 is considered a new installation.

Do the following tasks in the order listed to upgrade ViewMail for Outlook to a later version.

1. Confirm that ViewMail requirements and prerequisites have been met. See the “Requirements”
section on page 2 and the “Prerequisites” section on page 6.

Release Notes for Cisco ViewMail for Microsoft Outlook Release 9.0(2)
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M nstallation and Upgrade Information

~

Note

Prerequisites

Download ViewMail for Outlook from the Cisco Download Software website. See the
“Downloading ViewMail for Outlook 9.0(2)” section on page 9.

Optional: Customize ViewMail for Outlook setup for the upgrade, if applicable. See the
“Customizing ViewMail for Outlook Setup” section on page 9.

Optional: Provide users with ViewMail for Outlook files for the upgrade.

Upgrade ViewMail for Outlook. Provide users with instructions, if applicable. See the “Installing or
Upgrading to ViewMail for Outlook 9.0(2)” section on page 10.

Existing email account and ViewMail for Outlook settings remain unchanged during an upgrade.

Prerequisites for Using ViewMail for Outlook with the Single-Inbox Feature, page 6
Prerequisites for Using ViewMail for Outlook with IMAP, page 6
Prerequisite for Using ViewMail for Outlook with Cisco Unity 8.x or 7.x, page 7

Creating and Configuring an Account in Outlook to Access Voice Messages (IMAP Users Only),
page 7

Prerequisites for Using ViewMail for Outlook with the Single-Inbox Feature

For ViewMail for Outlook users who will access Connection voice messages by using synchronized
Connection and Microsoft Exchange mailboxes (single inbox), confirm that the following prerequisites
have been met:

The single-inbox feature is enabled.

(See the Unified Messaging Guide for Cisco Unity Connection at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/9x/unified_messaging/guide/9xcuc
umgx.html.)

An Exchange email account in Outlook points to each user’s Exchange mailbox.

Prerequisites for Using ViewMail for Outlook with IMAP

For ViewMail for Outlook users who will access Connection voice messages by using IMAP, confirm
that the following prerequisites have been met:

Users’ corporate email addresses are configured as SMTP proxy addresses.

(See the “SMTP Proxy Addresses in Cisco Unity Connection 9.x” section in the “Setting Up
Features and Functionality That Are Controlled by User Account Settings in Cisco Unity
Connection 9.x” chapter of the User Moves, Adds, and Changes Guide for Cisco Unity Connection
Release 8.x at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/9x/user_mac/guide/9xcucmacx.htm

L)
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Users are associated with a class of service enabled for accessing voice messages by using an IMAP
client.

(See the “IMAP Client Access to Voice Messages in Cisco Unity Connection 9.x” section in the
“Setting Up Features and Functionality That Are Controlled by Class of Service in Cisco Unity
Connection 9.x” chapter of the User Moves, Adds, and Changes Guide for Cisco Unity Connection.)

The Connection server is configured to allow SMTP connections from IMAP clients.

(See the “Configuring the Cisco Unity Connection Server for IMAP Client Access and
Authentication” section under “Procedures for Configuring IMAP Access in Cisco Unity
Connection 9.x” in the “Configuring IMAP Settings in Cisco Unity Connection 9.x” chapter of the
System Administration Guide for Cisco Unity Connection Release 9.x at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/9x/administration/guide/9xcucsagx
.html.)

If Transport Layer Security for untrusted IP addresses is configured to be required or optional: The
Connection server is configured to provide a secure IMAP connection.

(See the “Securing Cisco Unity Connection Administration, Cisco PCA, and IMAP Email Client
Access to Cisco Unity Connection 9.x” section in the “Configuring SSL in Cisco Unity Connection
9.x” chapter of the System Administration Guide for Cisco Unity Connection.)

An IMAP email account is configured in Outlook for each ViewMail for Outlook user.

(See the “Creating and Configuring an Account in Outlook to Access Voice Messages (IMAP Users
Only)” section on page 7 of these release notes.)

Prerequisites for Using

Prerequisite for Using ViewMail for Qutlook with Cisco Unity 8.x or 7.x

For ViewMail for Outlook users who will access Cisco Unity voice messages, confirm that an Exchange
email account in Outlook 2010 points to each user’s Exchange mailbox.

Creating and Configuring an Account in Outlook to Access Voice Messages (IMAP Users Only)

Revised June 14, 2013

Do the applicable procedure—depending on the Outlook version—for ViewMail for Outlook users who
will access Connection voice messages by using IMAP:

To Create and Configure an Account in Outlook 2010 or 2013 to Access Voice Messages (IMAP
Users), page 7

To Create and Configure an Account in Outlook 2007 to Access Voice Messages (IMAP Users),
page 8

To Create and Configure an Account in Outlook 2003 to Access Voice Messages (IMAP Users),
page 9

To Create and Configure an Account in Outlook 2010 or 2013 to Access Voice Messages (IMAP Users)

Step 1 Start Outlook.
Step 2 On the File tab, select Info, then Add Account.
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Step 3

Step 4
Step 5

Step 6

Note

Step 1
Step 2
Step 3
Step 4

Step 5

Step 6
Step 7

Confirm that Email Account (the default) is selected, then enter user information:

a. In the Your Name field, enter a display name for the account. This typically is the full name of the
user.

b. In the Email Address field, enter the Connection SMTP address of the user.

The address is available in the SMTP Address field on the User Basics page in
Connection Administration, and typically uses the following format:

<username>@<SMTP domain name of the Connection server or cluster>

c. In the Password field, enter the user’s Cisco PCA password (also known as the web application
password).

d. In the Retype Password field, enter the Cisco PCA password again.
Select Next.

If you see the “Problem Connecting to Server” message about an unavailable encrypted connection:
Select Next to use an unencrypted connection.

When the email-account configuration is complete, select Finish.

If Outlook 2013 is getting crashed when you click on Draft Message/Sent Message/Calendar/Contacts,
make sure that the IntResource64.dll library file does not exist in the %temp%\AppData\Local\Temp\

folder. If the file exists in the specified location, delete the file before starting Outlook to resolve this

issue.

To Create and Configure an Account in Outlook 2007 to Access Voice Messages (IMAP Users)

Start Outlook.
From the Outlook Tools menu, select Account Settings.
In the Account Settings dialog, on the Email tab, select New.

In the Add New Email Account wizard, select Microsoft Exchange, POP3, IMAP or HTTP as the
email service, then select Next.

Enter user information:

a. In the Your Name field, enter a display name for the account. This typically is the full name of the
user.

b. In the Email Address field, enter the Connection SMTP address of the user.

The address is available in the SMTP Address field on the User Basics page in
Connection Administration, and typically uses the following format:

<username>@<SMTP domain name of the Connection server or cluster>

c. In the Password field, enter the user’s Cisco PCA password (also known as the web application
password).

d. In the Retype Password field, enter the Cisco PCA password again.
Select Next.

If you see the Problem Connecting to Server message about an unavailable encrypted connection: Select
Next to use an unencrypted connection.
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Step 1
Step 2
Step 3
Step 4
Step 5

Step 6

Installation and Upgrade Information

When the email-account configuration is complete, select Finish.

To Create and Configure an Account in Outlook 2003 to Access Voice Messages (IMAP Users)

Start Outlook.

From the Outlook Tools menu, select Email Accounts.

In the Email Accounts wizard, under Email, select Add a New Email Account, then select Next.
Under Server Type, select IMAP as the email service, then select Next.

On the Internet Email Settings (POP 3) dialog, enter the applicable information in the User, Server, and
Logon sections, then select Next.

When the email-account configuration is complete, select Finish.

Downloading ViewMail for Outlook 9.0(2)

Step 1

Step 2

Step 3
Step 4

To Download ViewMail for Outlook 9.0(2))

On a computer with a high-speed Internet connection, go to the Voice and Unified Communications
download page at http://www.cisco.com/cisco/software/navigator.html?mdfid=280082558.

~

Note  To access the software download page, you must be signed in to Cisco.com as a registered user.

In the tree control on the download page, expand Products>Voice and Unified Communications>IP
Telephony>Unified Messaging>Cisco Unity Connection, and select Cisco ViewMail for Microsoft
Outlook Version 9.0.

In the Latest Releases folder, select VMO 9.0(2).

On the right side of the page, select Download Now, and follow the on-screen prompts to complete the
download.

Customizing ViewMail for Outlook Setup

The file AdminConfig.xml is available in the ViewMail for Outlook installation folder. Use the file to
prepopulate user and voicemail server information when the ViewMail for Outlook installation or
upgrade is being pushed out to users.

After entering information in AdminConfig.xml, leave the file in the ViewMail installation folder when
you make it available to users.
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Installing or Upgrading to ViewMail for Qutlook 9.0(2)

By default, ViewMail for Outlook files are installed in the directory C:\Program Files\Cisco
Systems\ViewMail for Outlook. You can specify a different directory during the software installation.

Do the procedure in this section to install or upgrade ViewMail for Outlook on user workstations. You
can also install ViewMail for multiple users who share a workstation.

To Install or Upgrade to ViewMail for Outlook 9.0(2)

Step 1 If Microsoft Outlook is running, exit the application.
Step2  In the ViewMail folder, double-click the applicable file:

Setup.exe Use this file for new installations and for upgrades from versions earlier than 9.0. It
installs prerequisite software, as needed; places the AdminConfig.xml file in the
correct location; and uninstalls older versions during upgrades.

This folder consists of two sub folders:
e  Win32: If you need to install 32-bit ViewMail for Outlook.
e x64: If you need to install 64-bit ViewMail for Outlook.
A
Note  For silent installation of ViewMail for Outlook, in AdminConfig.xml file,
the user id should be the login name of the system whereas the username

and password should be the user name and password of Cisco Unity
Connection.

ViewMail.msi Use this file for quick minor upgrades for VMO 32-bit with versions 9.0 and later

ViewMail_64.msi | Use this file for quick minor upgrades for VMO 64-bit with versions 9.0 and later.

Step3  Follow the on-screen prompts to complete the installation.

Stepd  Restart Outlook.

Installing ViewMail for Outlook 9.0(2) Using Command Line Switches

To install ViewMail for Outlook 9.0(2) through command line switches:

Step1  Run the following command on command prompt:

<Path of the VMO setup directory>setup.exe /i /qb /logfile <File Name>

~

Note  <File Name> is the name of the log file.

Step2  Restart Outlook.
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Associating the Applicable Email Account with the Voicemail Server

~

Note

Step 1

Step 2
Step 3

Revised June 14, 2013

If you are upgrading ViewMail for Outlook from 8.5(x) to a later version, skip this task. Existing email
account and ViewMail settings remain unchanged during an upgrade.

You must link the applicable IMAP account or Exchange account with the voicemail server. This ensures
that messages composed by using ViewMail for Outlook are sent to the voicemail server.

Do the following procedure on each user workstation.

To Associate an Email Account with a Voicemail Server

In Outlook, open the ViewMail Settings or Options dialog:

Outlook 2013 On the ViewMail tab, select Settings.

and 2010

Outlook 2007 From the Tools menu, select Options, then the ViewMail tab.

Outlook 2003 From the Tools menu, select Options, then the ViewMail tab.

Select Add, then select the account to associate with a voicemail server.

Enter the applicable information in each field:

Table 1 ViewMail for Outlook Settings

Field

Setting

Voicemail Server Type

Select the voicemail server type to associate with the email account.

~

Note In IMAP account, Cisco Unity Connection 7.x and 8.x
versions support Connection 7.x and 8.0.x voicemail server
type and Cisco Unity Connection 8.5 and later versions
support Connection 8.5 (IMAP) voicemail server type.

Username Enter the Cisco Unity Connection or Cisco Unity username (alias) of
the user.
Password Enter the user’s Cisco PCA password (also known as the web

application password).

Voicemail Server Name

Enter the name of the voicemail server.

Voicemail Server Status

Display only.

(Possible values are “Connected,” “Not Connected,” “Invalid
Credentials,” and “Unknown.”)

Phone Number

Enter the extension or a phone number for the user.

This setting is required only if you want Connection users to be able
to record or play messages by using the phone, or if you want
Cisco Unity users to be able to play messages by using the phone.
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Table 1 ViewMail for Outlook Settings (continued)
Field Setting
Recording Device Select the preferred device.

(This option is unavailable for Cisco Unity users.)

Playback Device Select the preferred device.

Step4  Select Test Settings to verify the information that was entered.

Step5  Select OK.

Limitations and Restrictions

Revised May 13, 2013
¢ Incompatibility with Exchange System Management Tools, page 12
¢ Installing a New Version of Outlook Requires Uninstalling ViewMail First, page 12

e Message Sensitivity Displays as Blank for Normal Sensitivity Messages Recorded in ViewMail,
page 13

e Some Software on User Workstations Can Cause ViewMail to Fail, page 13
¢ To Compose Voice Messages, Connection Server Must Be Available, page 13

e ViewMail for Outlook 9.0(2) Limitations Regarding Reply and Forward Cisco Unity Voice
Messages in Connection 9.0, 8.0, and 7.x, page 13

e ViewMail for Outlook 9.0(2) Limitations Regarding Cisco Unity 5 Message Playback, page 14
e ViewMail for Outlook 64 Bit Limitation Regarding G.729, page 14
e C(Caveats, page 14

Incompatibility with Exchange System Management Tools

ViewMail for Outlook version 9.0(2) does not work correctly when it is installed on a computer that also
has Microsoft Exchange System Management Tools installed.

Installing a New Version of Outlook Requires Uninstalling ViewMail First

When installing a new version of Microsoft Outlook on user workstations, you must first uninstall
ViewMail for Outlook. After you have installed Outlook, reinstall ViewMail.

Otherwise, ViewMail for Outlook will seem to be installed properly with the new version of Outlook,
but it may not work.
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Message Sensitivity Displays as Blank for Normal Sensitivity Messages
Recorded in ViewMail

Users whose Outlook clients are configured to display the Sensitivity field in the message-list view may
notice that messages recorded in ViewMail for Outlook with the Sensitivity set to Normal do not display
any text in the Sensitivity field.

Messages recorded by using the Cisco Unity Connection phone interface (as well as email messages
composed in Outlook) display “Normal” in the Sensitivity field.

Some Software on User Workstations Can Cause ViewMail to Fail

Note

Some security and VPN software installed on user workstations may cause ViewMail for Outlook to fail.
In particular, software that offers personal firewalls is problematic.

Exceptions may need to be added to the problematic software to allow ViewMail to work. Alternatively,
you can set up ViewMail so that users can play messages with audio devices on their computers.

In ViewMail for Outlook 9.0(2) and later, if the user connects or disconnects the audio devices, it is
recommended to restart Outlook, so that ViewMail for Outlook displays the status of currently attached
recording and playback devices only.

To Compose Voice Messages, Connection Server Must Be Available

In order to compose voice messages by using ViewMail for Outlook with Cisco Unity Connection 8.5
and later, ViewMail must be able to contact the Connection server. If the server is not available, users
will see the following message: “The requested action could not be performed because the voicemail

server was not available.”

In earlier ViewMail versions, voice messages could be recorded while the Connection server was
unavailable and were sent when the server became available again.

ViewMail for Qutlook 9.0(2) Limitations Regarding Reply and Forward
Cisco Unity Voice Messages in Connection 9.0, 8.0, and 7.x

In Connection versions 9.0, 8.0, and 7.x, users cannot reply to, or forward Cisco Unity voice messages
or .wav files by using ViewMail for Outlook version 9.0(2).

ViewMail for Outlook 9.0(2) Limitations Regarding Icon Update when a Voice
Message is read or unread

When a voice mail is marked read or unread using ViewMail for Outlook 9.0(2), the state of voice mail
Icon is not updated regardless of the Microsoft Outlook version.
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ViewMail for Qutlook 9.0(2) Limitations Regarding Cisco Unity 5 Message

Playback

When playing a Cisco Unity 5 message using ViewMail for Outlook with "VMO Play Attachment"
feature, audio progress bar is not updated and time duration is not displayed on the VMO audio pane of
the VoiceMail.

ViewMail for Outlook 64 Bit Limitation Regarding G.729

Caveats

Note

ViewMail for Outlook 64 bit version is not supported for G.729 codec.

You can find the latest caveat information for Cisco Unity Connection ViewMail for Microsoft Outlook
version 9.0(2) by using Bug Toolkit, an online tool available for customers to query defects according
to their own needs.

Bug Toolkit is available at www.cisco.com/go/bugs. Fill in your query parameters by using the custom
settings in the Advanced Settings option.

To access Bug Toolkit, you must be signed in to Cisco.com as a registered user.

Release notes for all versions of ViewMail for Outlook are available at
http://www.cisco.com/en/US/products/ps6509/prod_release_notes_list.html.

Open Caveats—Release 9.0(2)

This section lists the open caveats, which includes open CFDs (Severity 1,2, 3, 4, and 5) and IFDs
(Severity 1, 2, and 3) when ViewMail for Outlook version 9.0(2) was released. Select a link in the Caveat
Number column to view the latest information on the caveat in Bug Toolkit. (Caveats are listed in order
by severity, then by component, then by caveat number.)

Table 2 Connection ViewMail for Outlook Release 9.0(2) Open Caveats
Caveat Number Component Severity Description
CSCud20311 vmo 3 Outlook stops responding when viewing Votes

Resolved Caveats—Release 9.0(2)

This section lists the resolved caveats, which includes resolved CFDs (Severity 1, 2, 3, 4, and 5) and
IFDs (Severity 1, 2, and 3) when ViewMail for Outlook version 9.0(2) was released. Select a link in the
Caveat Number column to view the latest information on the caveat in Bug Toolkit. (Caveats are listed

in order by severity, then by component, then by caveat number.)
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Table 3 Connection ViewMail for Outlook Release 9.0(2) Resolved Caveats

Caveat Number Component Severity Description

CSCue68385 vmo 3 VMO 9.0 has compatibility issues with 3rd party plugin FileSite(iManage)
CSCuc87100 vmo 3 VMO - About Cisco Viewmail needs to show proper version
CSCud24949 vmo 3 Outlook fails to send out calendar event with VMO installed
CSCud86584 vmo 3 VMs generated by VMO lack Date field in header

CSCue38087 vmo 3 VMO 9.0 not working with EDOCs

CSCued8335 vmo 3 VMO 9.0.1 VMO ICONSs do not work with UC 9.1.1

CSCue53285 vmo 3 VMO 9.0(1) - Using Play Bar to Skip During Msgs Locks Outlook
CSCue34852 vmo 4 Adxloader DLL is not digitally signed which prevents VMO installation
CSCuc87100 vmo 3 VMO - About Cisco Viewmail needs to show proper version
CSCuc33637 vmo 4 VMO: Description is displayed in English

Obtaining Documentation and Submitting a Service Request

For information on obtaining documentation, submitting a service request, and gathering additional
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed
and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free
service and Cisco currently supports RSS Version 2.0.

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other countries. To view a list of
Cisco trademarks, go to this URL: www.cisco.com/go/trademarks. Third-party trademarks mentioned are the property of their respective owners. The
use of the word partner does not imply a partnership relationship between Cisco and any other company. (1110R)

Any Internet Protocol (IP) addresses and phone numbers used in this document are not intended to be actual addresses and phone numbers. Any
examples, command display output, network topology diagrams, and other figures included in the document are shown for illustrative purposes only.
Any use of actual IP addresses or phone numbers in illustrative content is unintentional and coincidental.

© 2013 Cisco Systems, Inc. All rights reserved.
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